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Getting Started 
1. Create a document using MSWord or other document software – make sure all instructions for 

your constituents are typed in the document so they will know how to complete the form. 
2. If you need help on Word Tables, visit http://unit.villanova.edu/workshops/manuals/ and look 

for the Word 2003: Tables handout. 
3. To create the PDF file from the original Word document: 

a. Save your Word document. 
b. Click File and select Print. 
c. From the printers list, change your printer to the Adobe PDF and click OK. (If you don’t see 

this option, you do not have Adobe Acrobat Professional.) 

d. Another way to make a PDF file from your Word document is to click the  Convert 
to Adobe PDF button on the Adobe toolbar in Word. 

e. When the “Save Adobe PDF As” window appears, select the folder you want to save the 
PDF file into and type a name for your PDF file (unless you want it to have the same name 
as the Word file). If you plan on posting your form on the web, be sure to use no spaces or 
caps in the filename (e.g., my employment application form name would be emp_app.pdf). 
Note: The default location for the PDF file may not necessarily be the same location as the original Word 
document. You may need to change the “Save in…” box to match the folder where the Word document has 
been saved - e.g., My Documents). 

http://unit.villanova.edu/workshops/manuals/
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f. Click Save. 
g. The Adobe PDF file will be created in the background. It may or may not appear on your 

screen (or on the taskbar below) when complete. If it does appear, you know it is done. If it 
does not appear, exit Word and open the folder where you saved the file, then double-click 
on the file. The file will open in Adobe Acrobat. DO NOT attempt to open the PDF file from 
within Word or the file will look like gibberish.  

h. If the Adobe file DID open up on your screen (or down in your taskbar), click on the file and 
maximize it. 

 

Creating the Adobe Form 
Once your new Adobe PDF file is open on your screen, you should make sure the following two 
toolbars are visible on your screen: 

1. Advanced Editing Toolbar – To turn this on, click View, Toolbars, Advanced Editing. If it 
already has a check mark next to it, then it is already on. 

2. Forms Toolbar – To turn this on, click Tools, Advanced Editing, Show Forms Toolbar. If this 
says Hide Forms Toolbar, then it is already on. 

You can use either of these toolbars to insert fields into your form. If using the Advanced Editing 
toolbar to insert your form fields, locate the 6th button on the toolbar, which is the Forms button. The 
Forms button has a down arrow located to the right of it. Click that down arrow to select the type of 
form field you want to insert into your form. If using the Forms toolbar to insert your form 
fields(recommended), simply select the type of field you want to insert by clicking the corresponding 
button on the Forms toolbar. 
Types of Form Fields to insert: 

1. Button - for action buttons (see below) 
2. Check box - allowing user to select multiple options 
3. Combo box - allowing user to select an option from a drop-down list (recommended) 
4. List box - allowing user to select an option from a scrolling list (not recommended) 
5. Radio Button - like a check box, but only allows user to select one button, as long as all buttons in 

group have the same field name  
6. Text – Most common  - used for text such as name, address, etc. 
7. Digital Signature - digital signatures - not supported by UNIT 

 
To insert a Text Field 

1. From either the Advanced Editing or the Forms Toolbar, click 
the Text Field Tool button. 

2. Click, hold and drag the mouse to draw the size of the form 
field you want to create. 

3. Don’t worry about the size of the field since you can always 
resize it later. 

4. The Text Field Properties box will appear (the tab you are on 
may vary): 
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a. Click the General tab and type a short name for the field, without using spaces (e.g., FirstName).  
Note: If you have two sections in your form that need the same data to be filled in (e.g., Name), you can give both fields 
the same name and once the user fills in one field, the other will automatically be filled in with the same data.  
In the Tooltip section, type a short description; preferably something to help the user understand 
what is expected.  For the hearing impaired, the field name displays the information requested.  For 
the sight impaired, the device for aiding the user will say the field name. 

If you want the field to be Required, place a check the Required box. Leave all other attributes on 
the General tab as is. 

b. Click the Appearance tab, define your border color and fill color, line thickness and line style. Then 
select your font color, type and size. If you leave the font size set to Auto, the font size will expand 
and shrink depending on the amount of text typed in the box. It is recommended that you select a 
fixed font size such as 10 or 12. 

c. Click the Options tab. If you are creating a large text box where you want the user to be able to 
type a lot of text, check the Multi-line box. Be sure to uncheck the Scroll long text box so that the 
text the use types does not scroll on forever. 

d. You do not need to click the Actions tab. 

e. The Format tab will allow you to define the text as a number, a percentage, a date field, time, zip, 
phone, SSN, or define your own type of script.  For normal text, this is not necessary. Note: If you 
limit this to something specific, such as Date, the user will get an error if he/she attempts to type a 
date any way other than the format you have specified. This can be frustrating for users. It is best 
not to set any type of limits. 

f. You do not need to click the Validate tab. 

g. The Calculate tab allows you to perform a calculation on the numbers entered into a text field. To 
calculate numbers, the Format of this field must be set to Number, as should the fields that you 
want to calculate. Once you set the Format to Number, you can click on the Calculate tab and 
select the second option (“The value is the sum of the following fields”). Click Pick to select the 
fields to be calculated and click OK and OK again. 
 

To insert a Check Box/Radio Button 
The difference between a Check Box and a Radio Button is that check boxes are used to allow users 
to select more than one option, where radio buttons only allow users to select one of the multiple 
options. If you have more than one check box, each field should have a different name. For a group 
of radio buttons, each field in the group should have the same name. 

1. From either the Advanced Editing or the Forms Toolbar, click the Check Box Tool or the 
Radio Button Tool. 

2. Click, hold and drag the mouse to draw the size of the form field you want to create (make 
them small). Don’t worry about the size of the field since you can always resize it later. 
a. Click the General tab and type a short name for the field, without using spaces. 

In the Tooltip section, type a short description; preferably something to help the user understand 
what is expected.  For the hearing impaired, the field name displays the information requested.  For 
the sight impaired, the device for aiding the user will say the field name. 

If you want the field to be Required, place a check the Required box. Leave all other attributes on 
the General tab as is. 

b. Click the Appearance tab, define your border color and fill color, line thickness and line style. Then 
select your font color, type and size. If you leave the font size set to Auto, the font size will expand 
and shrink depending on the amount of text typed in the box. It is recommended that you select a 
fixed font size such as 10 or 12. 
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c. Click the Options tab. This is where you will type your list for the drop-down or scroll list. 

For a check box, select the Check Box Style (disregard the Export Value) and select whether or 
not you want the check box to be checked by default. 

For a radio button, select the Button Style. In the Export Value, type the value for the first radio 
button (e.g., if it is a Gender button, type MALE). You should select the other radio buttons in this 
group and type a different Export Value for them (e.g., FEMALE). Then select whether or not you 
want the button to be checked by default and if you want “Buttons with the same name and value 
to be selected in unison.” 
 

To insert a Combo Box or List Box (Combo Box is drop-down; List Box is scrollable) 
1. From either the Advanced Editing or the Forms Toolbar, click the Combo Box Tool 

(recommended) or the List Box Tool. 
2. Click, hold and drag the mouse to draw the size of the form field you want to create. Don’t 

worry about the size of the field since you can always resize it later. 
a. Click the General tab and type a short name for the field, without using spaces. 

In the Tooltip section, type a short description; preferably something to help the user understand 
what is expected.  For the hearing impaired, the field name displays the information requested.  For 
the sight impaired, the device for aiding the user will say the field name. 

b. Click the Appearance tab, define your border color and fill color, line thickness and line style. Then 
select your font color and size.  

c. Click the Options tab. This is where you will type your items for your drop-down or list. 
i. In the Item box, type Please Select as your first item, then click Add. 

ii. Type each of the additional items on the list in the Item box, click Add after each item. 

iii. You can select an item and Delete it or Move Up and Move Down. You can also Sort the items 
on the list and Allow user to enter custom text (text that is not on your list). The “Commit 
selected value immediately” option is not necessary. 

iv. For List Boxes, if you want users to be able to select more than one item, check the Multiple 
Selection box. If you check this box, you must instruct users to use their Ctrl key to select more 
than one item and the field must be tall enough for you to see all items on the list. 

v. You do not need alter the Actions or Selection Change tabs.  
 
 
To insert a Button (Save Form, Print Form, Reset Form, Email Form) 
Important Note: Only those users with the full Adobe Acrobat (Writer) program can utilize the Save 
Completed Form and the Email Form features. Users who have only the Acrobat Reader can only 
save a copy of the blank form. Users with the Acrobat Reader can, however, Print the Completed 
form. 
Therefore, if your form is going to be used internally, you can create the Print Form, Save Completed 
Form and Email Form buttons, but if it will be used outside the University, you can only use the Print 
Form button. 
The Reset Form button will work with all versions of Adobe, including the Reader. 

1. From either the Advanced Editing or the Forms Toolbar, click the Combo Box Tool 
(recommended) or the List Box Tool. 
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2. Click, hold and drag the mouse to draw the size of the form field you want to create. Don’t 
worry about the size of the field since you can always resize it later. 

a. Click the General tab and type a short name for the field, without using spaces. 

In the Tooltip section, type a short description; preferably something to help the user 
understand what is expected.  For the hearing impaired, the field name displays the 
information requested.  For the sight impaired, the device for aiding the user will say the field 
name. 

Under Common Properties, change the Form Field: section to Visible but doesn’t print. 
b. Click the Appearance tab, define your border color and fill color (you can make it fancy), 

line thickness and line style. Then select your font color and size. You might want to make 
the font color larger than normal, such as 14 pt. 

3. Click the Options tab. Type a Label to appear on the outside of the button (e.g., Print Form, Save 
Form, Email Form, or Reset Form). 

4. Click the Actions tab. Leave the Select Trigger as is. 
5. In the Select Action dialog box, select the following action depending on what you want to button 

to do: 
 

Print the Completed Form 
o Leave the Select Action: field set to Execute a menu item. 
o Click Add. 
o From the Menu Item Selection box, click File and select Print… 
o Click OK. 
o Click Close. 

 
Save the Completed Form 

o Follow the steps above but choose File - Save As…  as the action. 
 

Email the Completed Form 
o Follow the steps above but choose File - Email as the action. 
 

Reset the Form 
o Change the Select Action: field to Reset a form. 
o Click Add. 
o Select the fields that you want to have reset when the user clicks the Reset button. If you want to 

reset all buttons, click Select All. If you want certain fields to always remain filled in (such as 
name and dept.), uncheck those fields. 

o Click OK. 
o Click Close. 

Aligning Fields by Size and Location  
When creating multiple fields, you do not need to worry about getting them perfectly lined up or 
exactly the same size as the other fields. You can use your Align and Size features to make one or 
more fields the same as another field. 
 
Aligning fields to the same location (plane) on your form 

1. To align move than one Text Field, click the Text Field Tool button so the Text fields 
become visible. 

2. Determine which field will be ’leader’ and make sure that it is aligned where you want the 
others to be. 
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3. Click on one of the text fields and hold your Shift key (NOT Ctrl) down, then click on the 
other fields you want to be aligned. They will all highlight in red except the last field you 
select, which will be blue. The blue field is the “leader”, which means that all the other red 
fields will align with the leader, so be sure to select your leader field last. 

4. When you are finished, right click on any of the selected fields and select Align, then 
choose top, bottom, left of right. All the red fields will line up with the blue leader field. 

 
Aligning fields to the same size on your form 

1. Determine which field will be ’leader’ and make sure that it is sized to the dimensions that 
you want the others to be. 

2. Click the fields that you want to follow the “leader”, holding your Shift key to select more 
than one. 

3. While still holding the Shift key, select the “leader” field, which should become blue. 
4. When you are finished, right click on any of the selected fields and select Size, then choose 

height, width or both. 
 

 

Setting The Tab Order On Your Form 
When users complete your form online, they will use their Tab key to move from field to field. Therefore, you 
will want to control where their cursor lands each time they hit Tab. This is called the Tab Order. To set the 
Tab Order on your form: 
 

1. On the left-hand side of your form, click the Pages tab (below Bookmarks and Signatures). 
2. Select the first page of your form and then click the Options button at the top of the Pages 

pane. 
3. Select Page Properties (if this is grayed out, you haven’t selected your page). 
4. On the Tab Order tab, select one of the options. Use Row Order is recommended. 
5. Click Close. 
6. Click the Hand tool and test your tab order by tabbing from the first form field down. 

Saving and Testing Your Form 
 
Saving Your Form 
 
As you are working on your form, you should be saving it often. To do this: 
 

1. Click File and select Save As… from the list. 
2. The filename of your form should already be in the filename list. 
3. Click Save. 
4. You will be asked if you want to overwrite the existing file. Click Yes, unless you want to give the file 

a new name. 
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Each time you save your form, you should complete the steps above. DO NOT click File, Save, but always use 
the File, Save As feature. This will keep your file from getting too large, as everytime you use the Save As 
feature, the file is compressed. 
 
Testing Your Form 
 
To test your form out, click on the Hand tool (looks like a white glove on the left-hand side of your toolbar. 
Complete the form, being sure to type in every field to see how things look. 
 
If you need to make changes to a field on your form, click on the form tool that corresponds with that field (e.g., 
if you need to change a check-box, click the Check Box Tool on the forms toolbar). Then double-click on the 
field you want to edit. 
 
Important Note: When testing your form out, if you click on the Save Completed Form button, be sure to give 
the file a new name, or else your form will be saved with everything you have typed. 
 
Before you post your form on your website or send it to anyone, be sure that your form is empty (that anything 
you typed in the fields when testing is now cleared out) and that all drop-down lists are set the Please Select 
mode. 
 
 

Editing Text On Your Form 
You can use the Text TouchUp Tool and the TouchUp Object Tool to add/remove text or objects (lines) from 
your form. However, using these tools increases the size of your file, so you should use these only in 
emergency. 
 
Using the TouchUp Text Tool 

1. Locate the Touchup Tool (looks like a big T) on the Advanced Editing Toolbar (two buttons over from 
your Form Tools). 

2. Click the down arrow to the right of the TouchUp Tool and select TouchUp Text. 
3. Click on the line of text you want to edit or add. The section will become highlighted in blue. 
4. Delete or add the text you want. 
5. Click the Hand Tool or the Form Tool when finished. 

 
 
Using the TouchUp Object Tool 
 

6. Locate the Touchup Tool (looks like a big T) on the Advanced Editing Toolbar (two buttons over from 
your Form Tools). 

1. Click the down arrow to the right of the TouchUp Tool and select TouchUp Object. 
2. Click on object that you want to remove. Sometimes it is hard to grab the object you want to delete, so 

you may have to keep trying. If it looks like it is selecting more than just the object that you want to 
delete, even though you clicked right on your object, try hitting Delete on your keyboard anyway and 
see what happens. 

3. Hit the Delete key on your keyboard. 
4. If you delete something you did not intend to, click on Edit and select Undo Delete. 
5. Click the Hand Tool or the Form Tool when finished. 
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What To Do If You Need To Redo Your Form 
If you need to make major changes to your form, you should go back to the original Word document, make the 
necessary changes, and recreate your PDF form. However, you do not need to redo the entire PDF form - 
rather, you can copy the fields from your first form and copy them to your newly-created form. To do this: 
 

1. Save your first Adobe form and close it. 
2. Open your Word document, make the changes, save the file and re-print the form to the Acrobat 

Distiller. 
3. When asked what you want to call your new PDF file, give it a new name - DO NOT overwrite your 

old PDF form. 
4. Once the new PDF file is complete, open it. 
5. Then in Adobe, click File, Open and open your old PDF form.  
6. You will not see both files open at the same time, but when you click on Window from the menubar 

above, you will see that both files are open. 
7. From the Window menu, select the old PDF form. 
8. You can now copy your form fields from the old form and paste them into the new form, but you 

must do each type of form field separately. For instance, you can copy all the Text Fields at once 
and copy and paste them to the new form. Then you can select all the Check Box form fields at 
once and copy and paste them to the new form, etc. 

9. To select and copy all of the Text Box form fields from your old form, select the Text Field tool from 
the Advanced Editing or the Forms toolbar. Then click Ctrl-A on your keyboard. All fields will be 
highlighted. 

10. Then hit Ctrl-C on your keyboard to copy all of the fields. 
11. Click Window again and return to the new PDF form. 
12. To paste all of the fields into this form, hit Ctrl-V on your keyboard. All of the fields will paste in, but 

they may not be in the correct location. DO NOT ATTEMPT TO MOVE THEM ONE BY ONE. 
FOLLOW THE DIRECTIONS BELOW TO MOVE THEM ALL AT ONCE. 

13. Being careful not to click anywhere with your mouse (you want all of your newly pasted form fields 
to continue to be highlighted), use your up, down, right and left keys on your keyboard to move the 
group of pasted fields into place where they belong. Then to move individual fields into place, click 
on a blank area of the form (to deselect the multiple fields) and move the individual fields into place. 

14. Add any additional fields you need to add to the form. 
15. Click File, Save As to save your new form. 

 

Creating Hyperlinks on Your Form 
 
To turn typed website addresses in your document into active hyperlinks 
If you have any website addresses typed on your form, you can easily turn them into active clickable 
hyperlinks. They can begin with http:// or just with www. To do this: 

1. Click Advanced from the menubar above and select Links. 
2. Select Create from URLs in Document... 
3. You will be prompted as to which page you wish to establish links.  The default is all pages. 

Leave that selected and click OK. 
4. It will tell you how many links it has made. 
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5. To test your link by clicking the Hand tool and clicking your links, then select whether you want 
the link to load in Adobe or a Web Browser (browser recommended). 

 
To establish an individual link, including an email link from plain text 

1. Select the Link Tool  on your Advanced Editing Toolbar. 
2. Highlight the text you wish to hyperlink. 
3. Once you have outlined the desired text, a Create Link box will open. 
4. Define the desired Link Appearance (type, highlight style, line thickness/style, and color). 
5. Under Link Action, select the action you want it to take. If you are not sure which to use, 

click the Help button on that page. If you want your link to take the user to a website, select 
“Open a web page.” 

6. Click Next. 
7. Type or paste the URL for the link (no need to type http://). 
8. If you are establishing an email link, use “Open a web page” as the Link Type and then 

instead of typing a website, type the email address preceded by mailto: (e.g., 
mailto:someone@somewhere.edu). 


